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Class X 

INFORMATION TECHNOLOGY(402) 

 

Time: 2.5 Hrs                Maximum Marks: 50 
------------------------------------------------------------------------------------------------------------------------------- 

Section A 

: Attempt any ten from the following    10 x 1=10 

 
1. What is kept on ________ table 

a. an       b. the     c. of             d. a    

Ans :   the 

2. The chemist shop is right next ____ the hospital. (for, to). 

Ans :   to 

3. www stands for ________________   .  
(a) Whole World Web 
(b) World Wide Web 
(c) World With Web 
(d) Web Web Web 

Ans :      (b)  World Wide Web 

4. _____________   is designed to help users with auditory impairments. 
(a) Filter Key 
(b) Toggle Keys 
(c) Sound Sentry 
(d) Serial Key 

Ans :    (c)  Sound Sentry 

5. Default tab stop position is __________ . 

Ans :     0.5” 

6. _______________ can be used to break continuous text to one or more sentences. 

Ans : Paragraph 

7. ______________ can be used for inserting information at the top of each page automatically.   

Ans :   Header 



 
8. AutoSum  option  is  available  in  _________________  group  under  the Home tab. 

Ans : Editing 

 
9. __________   are used for playing sound files while making a presentation. 

Ans : Audio clips 

10. Selecting the__________  view  shows  calendar  for  a month. 

Ans : Month 

 
11. You can categorize appointments in time management software by giving specific 

__________ to appointments. 

Ans :   colours 

 
12. A _________________  creates a timeline of transactions that can be linked to a contact. 

Ans :   Journal 

 
Very short Answer Questions      (5X2=10) 

13. Rohan’s father told him that they need to attach a modem for internet connection on their 
computer. Explain the meaning and function of modem to Rohan.  

Ans :  A modem is a device that converts digital computer signals into a form (analog signals) 
that can travel over phone lines. It also re-converts the analog signals back into digital signals. 
The word modem is derived from its function MOdulator/DEModulator. 

 

14. What are document templates? State the purpose of using document template.   (2) 

Ans : Templates  or  document  templates  refer  to  a  sample  fill-in-the-blank  document  that can 
help  in  saving  time. Usually templates are customized documents that may have sample content, 
themes, etc.   For example, if you want to create a resume you can use a resume template and modify 
only the sections that require changes.   

Or 
15. What are Clip arts? List any two websites that offer free clipart.    (2) 

Ans:  Clip arts are pre-defined images available for use in documents. Clip Art can help in making a 
document look colourful and presentable. 1 mark 
 
Name of any two valid websites that offer free clipart     ( ½ + ½ =1 mark)  
 



 
16. Explain any two types of views available in Spreadsheet (2) 

Ans : five types of views are ; 

 Normal View: The default view of the spreadsheet application is the Normal. It is a collection of 
cells arranged in the work area.  

Page  Layout:  You  can  select  the  Page  Layout  view  in  order  to  quickly  fine  tune  a  
worksheet that contains many charts or huge amounts of data and achieve professional  looking 
results.  

Page Break Preview: This option is similar to the Page Layout option except you can set the area that 
is to be set as a page after inserting page break.  

Custom Views:  If you would like to view selected areas of a document, you can use the custom view 
option. For example, if you would like to point out certain row and column, you can add that to the 
Custom view.  

Full Screen: Selecting this option makes the workbook cover the entire screen. All tabs are hidden 
from view. To get back the tabs, click on File> Restore.   

 

(Any two views)  

 
17. Explain the purpose of grouping objects in a Digital presentation.  (2) 

Ans: Grouping  can  help  when  you  want  to  move,  rotate  or  resize multiple  objects  in  a 
presentation. You can group objects such as pictures, clip art, shapes and text box; once grouped they 
appear as a single object.   

2 marks for any two valid points 

Or 
18. Differentiate between Animation and Transition in Digital Presentation. 

Ans : Animation is used for applying effects on objects and text,  

Transition is used for applying animation effects on slides 

(2 marks for any two valid points of difference) 

19. Pulkit has got a proposal for a meeting through Calendar. Suggest four types of responses 
that are available under calendar software. 

Ans : Four types of responses for a meeting are : 

 Accept,  
 Tentative,  
 Decline or  
 Propose New Time options 

(1/2 mark for each type, total 2 marks) 



 
Short Answer Questions       (5X3=15)   
   

20. A stranger has helped your grandfather and you want to appreciate him for the help extended 
by him. Write any three lines to thank him.  

Ans :   Thanks a lot!  

Thanks! You helped my grandfather.  

  Thanks! I really appreciate your help 

 

(any three phrases). 

21. You have recently visited a hill station. Describe it using appropriate phrases.  

Ans : Example: Nainital is a beautiful hill-station in Uttarakhand.  
  

1. Nainital is a beautiful hill-station…  

2. It is surrounded by…  

3. …in Uttarakhand.   

4. …above sea-level.  

5. …high mountain peaks  

6. Nainital is a very…  

7. …especially during winter…  

8. …popular tourist spot,  

9. …when the snow falls. 

(3 marks for 3 Sentences using any of the above phrases) 

22. List any three word wrapping options available under Word Processing software. 

Ans : Various word wrapping options are :  

- In line with text 
- Square 
- Tight 
- Through 
- Top and bottom 
- Behind text 
- In front of text 

(3 marks for any of the three options) 



Or 
23. Write steps to insert shape in a word document. 

Ans : Steps to insert shapes are :- 

1. Click on the Insert tab on the Ribbon. Click on the option Shapes in the Illustrations group 

2. Once you click the Shapes option a dropdown list with pre-defined shapes such as box, circle, etc. 
appears.   

3. Select the shape from the list of shapes available and draw the shape by dragging the mouse with 
the left button clicked. For example, if you like to insert a square, select the box shaped item from the 
list, click and drag the shape to draw a square.   

(3 marks for correct sequence of steps) 

 
24. Yashika is preparing a Digital Presentation for her project. Give any three basic guidelines to 

be followed while making a digital Presentation. 

Ans : Do a thorough spell check across all slides  

- Perform a manual spell check for terms that are not included during the standard  spell 
check  in the presentation software; NOT all terms (particularly technical terms such as 
biological names, etc.) will be checked  

- Remove irrelevant content such as images or clip arts, terms, etc.  if they are not 
required. 

(any three valid guidelines)  

(1 mark for each guideline) 

Or 
 

25. Ankush has to present monthly report of his department to his managing committee. Suggest 
him with appropriate tools to do the following in a digital presentation: 

i. To show statistical data pictorially for analysis. 

Ans :    Charts  may be used  

                                                                                                                                               (1 mark)  

ii. Two ways to insert movie in his presentation. 

Ans:  You can insert a movie in two ways:  

 Using Insert tab  
 Using Title and Content Layout Option                                                                     (1 mark) 

 
iii. Which option he shall use to keep guided text used by presenter  

Ans : He should use Presenter View  in Slide Show Tab       (1 mark) 

  



26. Define the following terms 
a. Tuple :   

A row also called a record or tuple represents a single, data item in a table 
b. Foreign Key  

The foreign key identifies a column or set of columns in one (referencing) table that 
refers to a column or set of columns in another (referenced) table. 

c. DBMS   : Database Management System is a software package with computer 
programs that controls the creation, maintenance, and use of a database 
 

 

 
Section B 

Long Answer Questions                 (5X3=15) 

27. Ananya uses Internet for her School Project. Suggest any five security measure to ensure 
safety from online threats. 

Ans : Five safety measures : 

i) Use antivirus and antispyware software  
ii) Use  strong passwords 
iii) Backup  your  data: 
iv) Use  encryption  software 
v) Keeping  your  username  and  password  private 
vi) Do  not  share  personal  information 
vii) Secure transactions: 

(5 marks for any 5 valid security measures) 

(1 mark for each) 

Or 
28. Explain the following terms : 

a. Internet  : The Internet is a global system of interconnected computer networks 
that use the standard Internet protocol suite to serve billions of users worldwide 

b. LAN : A  local area network  (LAN)  is one which connects computers and 
devices  in a limited  geographical  area  such  as  home,  school,  computer  
laboratory,  office building, or closely positioned group of buildings 

c. Instant Messaging: Instant messaging (IM) is a form of communication over the 
Internet that offers an instantaneous transmission of text-based messages from 
sender to receiver. 

d. Blog  :    A  blog  is  a  discussion  style  site  used  by  non-technical  (and  
technical  users) users  for creating personal web pages. 

e. P2P Architecture  : Peer to Peer  : Networks  in which all computers have an equal 
status are called peer to peer networks. 

 

  



29. Write command to create a table named ‘BOOK’ with following fields: 

BOOK ID       Char(4) 

Bname Varchar(15) 

Author             Varchar(20) 

Price                Decimal 

Ans: 

Create table BOOK 

(     BOOK_ID       char(4), 

Bname varchar(15), 

Author             varchar(20), 

Price                Decimal   ); 

(2 marks)  
 

a. Identify the primary key of the ‘Book’ Table, also mention the suitable reason for choosing 
it as a Primary Key 

Ans : Book_id may be chosen as the Primary key because every book has a unique id that may 
be used to identify the book. 

( ½  mark for primay key and ½ mark for reason) 

b. Differentiate between (i) char and varchar datatype 

Ans :    char  :   

1. Stores exactly the length specified by user in field definition. 
2. Pads with trailing spaces for shorter strings 

varchar:   

1. It Stores up to the specified length.  
2. No   padding with extra spaces 

(1 mark   for 1 correct difference) 

(ii) DDL and DML 
 
DDL : A data definition language or data description language (DDL) is a standard for 
commands that define the different structures in a database 
DML : A data manipulation language (DML) is a language that enables users to access and 
manipulate data in a database. 

 (1 mark   for 1 correct difference) 



OR 
30. Write the SQL commands to answer the queries based on Fabric table 

FabricID Fname Type Disc 
F001 Shirt Woollen 10 
F002 Suit Cotton 20 
F003 Tunic Cotton 10 
F004 Jeans Denim 5 
F006 Shorts Cotton 7 
 

a. To insert the following record 
(“F005”, “Kurta”, “Woollen”,5) 

  Ans : insert into Fabric values (‘F005’, ‘Kurta’, ‘Woollen’,5); (1 mark) 

b. To display only those fabric whose disc is more than 10 

Ans :   select * from Fabric where Disc>10;   (1 mark) 

c. To display those record whose type is ‘Woollen' 

Ans : select * from Fabric where type = ‘Woollen’;  (1 mark) 

d. To modify the fabric shirt by increasing discount by 10  

Ans :    update fabric  

              set Disc =Disc + 10 

       where Fname = ‘Shirt’;     (1 mark) 

e. To delete the record of fabric F003 from table 

Ans : delete from Fabric where FabricID =‘F003’;  (1 mark) 

 

31. Given the Following  Spreadsheet, Write the appropriate Formula/ Expression/ Function to 
be used for (a) to (e)          (5) 

 
a. Write formula to calculate the Total Qty(C4:C7))  in cell C8 

       Ans :       =sum(C4:C7) (1 mark) 



b. Write the feature used for arranging the Price from Highest to Lowest 

Ans :   Sort in ‘Sort and Filter’ group under Data tab  (1 mark) 

c. To find the Maximum Price to be written in Cell D10 

Ans :    = max(D4:D7)  (1 mark) 

d. To find the Average Qty to be written in cell C9 

Ans :    = average(  C4:C7) (1 mark) 

e. Write formula to calculate the Total Amount   in cell E8 

Ans :    = sum(E4: E7) (1 mark) 

 


